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AlphaSmart Pro Keyboard

Publisher: Retail Cost: $ 249.00

Intelligent Peripheral Devices
20380 Town Center Lane, Suite 270
Cupertino, CA 95014

408-252-9400

http:/ /www.alphasmart.com
info@alphasmart.com

System Requirements:

This keyboard is compatible with the following computers:

Macintosh: Apple IIGS, Macintosh Classic, LC, II, Quadra, PowerBook,
Centris and Performa models and Power Macintosh models.

PC Machines
PC AT, PS/2, 286 models, 486 and Pentium models

Description:

AlphaSmart® Pro is a portable inexpensive, battery operated keyboard with
a small LCD screen which displays text as it is typed. about 160 characters
of text (4 lines by 40 characters) can be displayed at any one time. Text
entered can be transferred to a PC or Mac computer for formatting and
printing. Each keyboard comes with two cables, one for connecting to a PC
and one for connecting to a Mac. The keyboard runs 60-200 hours on just
two AA alkaline batteries. Its advanced electronics allow approximately 60-
200 hours of battery life. Data is saved automatically, and a long-lasting

lithium battery protects your students' work--even when the unit is turned
off.

Four keyboard layouts are available: QWERTY, left-handed, right-handed
and regular Dvorak. It also supports a sticky keys function and a key repeat
control. Eight different users can have a file on the keyboard.

Recommended Uses

This keyboard is a cost effective alternative to having portable computers for
dysgraphic students to check out and take to class for note-taking.

Notes:
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BookWise Edge ver 3 (win 95)

Publisher: Retail Cost: $ 5995.00

Xerox Imaging Systems

9 Centennial Drive

Peabody, MA 01960

(800) 248-6550 or (508) 977-2000
WWW.Xerox.com

System Requirements:

BookWise 3 will run on any IBM PC 386 or greater with 8 MB RAM and 20
MB of free disk space. BookWise 3.0 is supported on both Windows
platforms. A scanner and sound card are necessary if the Reading Edge is
not used with BookWise. See the "Notes" section at the end of this guide.

Description:

BookWise Edge is BookWise software running on a PC attached to the
Reading Edge scanner which also serves as the synthesizer source.
BookWise software alone can be installed on a PC which is attached to a
regular scanner and a compatible sound card used as the speech synthesizer
source. BookWise is a PC-based interactive system which scans books and
other printed materials, converts the text to synthesized speech, highlights
the text, and reads it aloud. Bookwise recognizes almost any printed text,
including faxed, typewritten, laser-printed and photo-copied materials, and
the program recognizes almost every type style from size 8 to 72 points.

BookWise is able to:

* Read at a syllabic, word, phrase or sentence level
* Read at different speeds

* Adjust speech loudness

* Edit scanned text

Recommended Uses:

BookWise is recommended for students who will benefit from a multisensory
approach to reading: hearing and seeing.

Basic Use:

1. Turn on Reading Edge and place material to be scanned in scanner.

2. Tap the Select Input key of reading keypad until "Receive ScreenReader
input" is heard.
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. Turn on computer; select BookWise from the menu
. Click the Scan icon to start scanning.

3
4
5. Give file a name and save the text file; text will appear on-screen.
6. Begin automatic reading by clicking the Green Arrow icon.
7
8

. It is possible to edit this scanned text.

Explore the menu options for other available settings (e.g., colors, font

and size of text, etc.)

Notes:

Pricing:

BookWise System 1

(Includes BookEdge Scanner; BookWise 3.0;
read/scan software, and PC DECtalk
synthesizer with speakers.)

BookWise 3.0 Read/Scan station software
with PC DECtalk speech

BookWise 3.0 Read/Scan station software

BookWise 3.0 Read station software
with PC DECtalk synthesizer

BookWise Read station software
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Creative WrIter ver 1.0 (Mac)

Publisher: Retail Cost: $ 29.95

Microsoft Corporation (Headquarters)
One Microsoft Way

Redmond, WA 98052-6399

(800) 426-9400

www.microsoft.com

System Requirements:

Apple Macintosh Plus or higher; recommend system 7.0 for color display; 4
MB memory; 8 MB available hard-disk space; printer. Will import images in
PICT format or Fine Artist format; sound import requires AIFF or AIFC

format. Plain text files can be imported as well as files from Microsoft Word
and Works.

Description:

This entry level program allows the user to create graphics-filled text for fun
or for reports. Designed for children, it is relatively easy to use.

Recommended Uses:

For students wanting to learn about the basics of computer-based document
production, this program is a nice introduction. Because the program is
network friendly, it can be installed on a server; only one machine may use
the program at a time, although it may be installed on many machines.

This program has icon-based menu bars; clicking on an icon provides spoken
context-sensitive help or directions. The icons are very intuitive and
appropriate.

Notes:
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Dragon NaturallySpeaking (1.0) (Win)

Publisher: Retail Cost: $350.00 approx.

Dragon Systems
320 Nevada Street
Newton, MA 02160

(800) 825-5897
www.dragonsys.com

System Requirements:

Microsoft Windows 95 or newer, or Windows NT, 133 MHz or faster, 32 mb.
RAM for Windows 95, 48 mb. RAM for Windows NT.

All systems require a sound board, Currently, the following soundcards have
been tested and certified for Dragon NaturallySpeaking:

Sound Blaster 16 PnP (Creative Labs, Inc.)

Sound Blaster AWE32TM PnP (Creative Labs, Inc.)

Sound Blaster AWE64TM PnP (Creative Labs, Inc.)

Sound Blaster AWE64TM Gold PnP (Creative Labs, Inc.)

AudiotrixTM Pro (MediaTrix Peripherals, Inc.)

EnsoniqTM SoundScapeTM VIVO 90 (must be purchased
directly from Ensoniq, Corp.)

EnsoniqTM Audio PCI (32-bit) (Ensoniq Corp.)

ExpertMedia Med 3240 with OPTi chip set (Expert Media)

Turtle BeachTM Tropez Plus (Turtle Beach Systems).

Description:

Dragon NaturallySpeaking is a speaker dependent, continuous speech
recognition system. The active vocabulary size is 30,000 words with a
230,000 word dictionary which allows for accurate word prediction and
spelling. Text can be dictated at around one-hundred words per minute. At
the present time, the system accommodates only one voice profile per
computer.

Recommended Uses:

This program is recommended for persons with repetitive strain injury or
moderate to severe physical disabilities.

Basic Use:
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Dragon NaturallySpeaking must be individually trained by each user.
Training is accomplished through use of the General Training program.
Creating a voice profile and completing the training process takes about 45
minutes. Unlike previous versions of Dragon Dictate which were always
used in combination with other programs, often, word processors,
NaturallySpeaking works within its own dedicated word processing
environment and is intended for text dictation rather than applications
control. When using NaturallySpeaking, the following steps are taken:

1. Load NaturallySpeaking from the Programs menu.
2. Activate the microphone by pressing the numeric keypad + key.

3. Begin speaking clearly and distinctly in short phrases with brief pauses
between each phrase.

4. If a phrase or word selected by NaturallySpeaking is incorrect say
"Correct" and the word or phrase to be corrected.

5. If the correct phrase or word appears in the suggestion list, say "Choose"
and then the number of the desired phrase or word in the selection box.

6. If the desired phrase or word does not appear in the selection box, say
"Spell That" and begin spelling the word using the letters of the
alphabet. Generally, the correct phrase or word will be identified after
the first one or two letters have been spoken. When the desired phrase or
word appears, say "Choose" and the number of the phrase or word.

Intermediate Use:

Users can insert punctuation marks by saying the name of the mark, (i.e.
"period", "comma", "question mark"). A variety of options exist for
selecting text. Saying "Select" then word, line, paragraph or document
selects a portion of text which can then be edited or formatted in a number of

ways. (See attached Quick Reference Guide)

Notes:

Speaking distinctly and in short phrases will dramatically improve
recognition performance. Saying "Thank you for your letter" brief pause
"inviting me to the opera" brief pause "next Saturday night." will work better
than saying the whole sentence.
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NaturallySpeaking

At a glance, here are all the voice commands grouped according to when you
can say them.

Global Commands

Microphone Off

Go to Sleep/Wake Up

Click (Menu or Button Name)

Move Left/Right/Up/Down 1-20

Move Left/Back/Right/Forward 1-20 Characters
Move Up/Down/Back/Forward 1-20 Lines
Select Next/Forward/Previous/Back Character
Select Next/Forward /Previous/Back Lines
Delete Next/Forward /Previous/Back Character
Delete Next/Forward/Previous/Back 1-20 Characters
Undo Last Action

Undo That

Copy All to Clipboard

Paste That

Switch to Next/Previous Window

Switch to Next/Previous Window

Switch to NaturallySpeaking

What Can I Say

Give Me Help

Give Me Help on (Topic)

Editing Commands

Go to Top/Bottom
Move Left/Back/Right/Forward/a word
Move Left/Back/Right/Forward/ 1-20 words
Move Left/Back/Right/Forward/ a paragraph
Move Left/Back/Right/Forward/ 1-20 paragraphs
Move to/Go to
Top/Start/Beginning/End of line/Paragraph
Document/Selection
Select Word/Line/Paragraph/Document
Select Next/Forward /Previous/Back Word
Select Next/Forward/Previous/Back 1-20 words
Select Next/Forward /Previous/Back Paragraph
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Select Next/Forward/Previous/Back 1-20 Paragraphs
Set Font (Face/Size/Style)

face = Axial, Courier, Courier New, Times,

Times New Roman

size = 4-120

style = Bold, Italics, Plain, Plain Text,
Regular, Underline

Dictation Commands

New Line/Paragraph
Tab Key

All Caps

All Caps On/Off
Caps

Caps On/Off

No Caps

No Caps On/Off

No Space

No Space On/Off

Correction Commands

Scratch That

Correct That

Correct text

Select text

Select Again

Spell that abc

All Caps That/Selection
Cap That/Selection

No Caps That/Selection

Correction Dialog Box Commands

Choose 1-10

Select 1-10

Select Line

Select Next/Forward/Previous/Back Word/Character

Select Next/Forward /Previous/Back 1-20 Words/Characters
Move Left/Back/Right/Forward a Word /Character

Move Left/Back/Right/Forward 1-20 Words/Characters
Move to Top/Start/Beginning/Bottom/End of Line
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Go to Top/Bottom
Go to Top/Start/Beginning/Bottom/End of Line
Cut That/Selection
Delete That/Selection
Delete Next/Forward /Previous/Back 1-20 Words/Characters
abc = Letters a-z, numbers 0-9 apostrophe, dash,
hyphen, spac Itse bar, Cap, question mark,
slash
other punctuation marks (say with a brief pause)
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End Note Plus (win)

Publisher: Retail Cost: $ 129.00

Niles & Associates, Inc.
800 Jones Street
Berkeley, CA 94710

System Requirements:

EndNote Plus is a 32-bit application and runs under the following operating
systems: Windows 3.x, Windows 95 or NT 3.5 or later for Intel processors. If
running in Windows 3.x the program requires Win32s, which is installed
automatically if needed. The program will not run under the OS/2 operating
system.

Hardware requirements: an IBM PC or compatible computer with a
386/DX/25 MHz processor (or higher) and a minimum of 4 MB of RAM (8 MB
recommended; a hard drive with at least 5.5 MB free space (6MB if using the
ADD-in for Microsoft Word or WordPerfect; at least 5.5 MB or virtual
memory (6 MB if using the add-in for Microsoft Word or WordPerfect); a
mouse.

Description:

EndNote is a bibliographic database program used to manage references and
create bibliographies. The new Add-in now enables users to complete all of
their bibliographic tasks, such as inserting citations and creating
bibliographies, using commands in WordPerfect's and Word's Tools menu.

This new version of EndNote is designed to work with Microsoft Word 6, 7
and Word 97. It also works with current versions of WordPerfect and
integrates seamlessly into these word processors. In addition, version 2.3
includes the ability to print directly from EndNote.

Recommended Uses:

Although EndNote can be used to support complex research projects, it also
can be used simply. In its simplest use, the program provides an easy way
for students to learn about organizing reference information. In a project,
when all reference information has been gathered and entered into an End
Plus library, it is not hard to place citations in text or to automatically format
a bibliography.
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Basic Use:

To Add a Reference Item in a Microsoft Word document:
Start

AP

. Open End Note from the Tools menu.

Close the open window by clicking on the close box.

Select Open from the File menu.

Give this file a name; End Note will automatically add a .enl extension.
Set the directory for saving: In location list box, click on Program Files,
then End Note, then Examples.

Enter References

1.

2.
3.

4.

From the End Note References menu, select New. A New Reference
sheet appears.

Fill in the data.

Close the data window; the reference automatically appears in the open
library window.

Continue to add references following the same process.

Adding references to Text

1.

2.

3.

4.

To add a reference citation to text in a document, place the cursor at the
end of the word where the reference is to go. Tap the Spacebar once.
Toggle to the End Note screen and select the reference to be inserted. Use
the keyboard command Alt-2 to have End Note insert a text reference in
the document.

Toggle back to the Word document and position the cursor at the location
of the next citation site.

Continue adding references to the document in the same manner.

Add Bibliography
1. Position the cursor at the place where the bibliography is to go. To format

the bibliography, go to the Word Tools menu and select Format

Bibliography. Select the desired style from the Style list box and then
click Format.

Notes:

An example of text containing references and an abridged bibliography. The
bibliographic text was entered by End Note. All formatting was done by End
Note.

Sample Text:
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These are books of life: the stories of two siblings (Norris, 1962; Norris,
1965). The son referenced is the father of two daughters, Rebecca (Norris,
1993), Audrey (Norris, 1994), and a son, Jack (Norris, 1994). The daughter
referenced is the Auntie.

Bibliography

Norris, A. (1994). Hi, There.

Norris, G. (1962). The Beginning of Life.
Norris, J. (1997). Well Hello.

Norris, M. A. (1965). Another Beginning.
Norris, R. (1993). Hello .
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Hand Writing Fonts ( Mac/Win CD-ROM)

Publisher: Retail Cost: $10.00

Expert Software, Inc.
800 Douglas Road
Coral Gables, FL 33134

System Requirements:

A PC computer with a CD-ROM drive, Windows 3.1 or Windows 95, VGA or
SVGA, 4 MB RAM or more. A Macintosh with 68020 CPU or higher, System
7 recommended, 5 MB RAM, CD-ROM drive.

Description:

This hybrid disc contains 300 TrueType fonts created from real handwriting
samples. Fonts represent male and female script, and cursive as well as
formal printing styles.

Recommended Uses:

Use of a handwriting font for some documents may provide students with
dysgraphia, or who are physically disabled and unable to write, with a sense
of being able to create personal messages

Basic Use:

1. Once the program is installed, open it from the Program Menu.

2. Launch the Font Browser.

3. Select fonts to be installed; the program suggests no more than 10. Make
a list of font names.

Close the Font Browser.

Move the highlight to a font name and click the Install button.

Repeat the process until all desired fonts have been installed.

Close the Hand Writing Fonts program.

From the Start Menu, select Settings and then Control Panel.
Double Click on the Fonts panel in order for it to update and recognize
the just-installed fonts. The fonts will now be recognized by other
applications (e.g., Word).

WO No ok
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Notes:

Examples:

llas is o sa,rl 0Pe of AcAcitre,' s ferK.t. 37S-47/0
This is a. Sa.rypte ok Brocils -Coo+, 315-4110
This 'ts c1 sample o-F gemmp> 's font. 375-4710

I'’AB5 65 a 1V (e Of er tael font. 375-'1-7/0

W% %0-14*4 - Of 4(AA.i 3-75-4-7\ 0
Tki3 L5 A Sample of pave's fomL. 375-4-110
162.frw-pie_ gce-r_4_ebn:1 /-opt,e;
TAis  ail sa/po/e a Ed/pa/161's fold- 37.5"--X710
76s is a sarnOe o Morgan’s C-onk. 3154110
5  SO\Vve?te- SC.OAMANtI'S 37S---q710
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Inspiration 5.0 Educational Edition (win)

Publisher Educational Cost $89.00

Inspiration Software Inc.

7412 SW Beaverton Hillsdale Highway
Suite 102

Portland, OR 97225

(800) 877-4292

www.inspiration.com

System Requirements
386 processor or higher, 8 MB RAM, Windows 95, VGA or better video

Description

Inspiration is an application that assists users to express thoughts effectively
by integrating easy-to-use diagramming and outlining. Concepts entered can
be viewed as a chart or as text by easily switching from one view to the other.

Inspiration is based on the visual creativity concepts of mind-mapping and
clustering. Mind-mapping comes from the work of Tony Buzan and his book,
Use Both Sides of Your Brain. Mind-mapping is used for memory retention,
note taking, and creative thinking. Clustering is a creative writing
technique presented by Dr. Gabriele Rico in her book, Writing the Natural
Way. Clustering is non-linear, visual and has a free form style that assists
the user in associating thoughts and reducing the barriers to creative
thinking.

Recommended Uses:

Inspiration can be used for brainstorming and creating a visual
representation (diagrams, charts and plans) of thoughts through the use of
symbols that hold each concept and associated linking ideas. In text, the
same concepts and ideas can be represented through outline topic levels. The
program design allows for easy organizing, rearranging, prioritizing and
adding of details, which enable the user to create a dynamic document.

Basic Use:

The following activity will take the user through initial steps of creating a
visual outline.

Main Idea and Sub-Categories

enter: The Role of Pets
click on: an arrow in the shape palette
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type: a source of income

click on: The Role of Pets

click on: an arrow in the shape palette
type: provides company

To Do Rapid Fire

press: enter (from the keypad)
type: for children

press: enter
type: for the sick

press: enter
type: for the elderly

press: enter

To Create Different Shapes

dick on: provides company
click on a shape from shape palette

To Delete Links

click on: arrow from Role of Pets to Source of Income
press: delete key

To Draw Links
select: The Role of Pets
position pointer on diamond-shaped handles at the top

click and drag the link to the Source of Income symbol
(to delete link, select it and delete)

To Edit Diagram or Outline

click and drag items anywhere

Adding Text to Link

type: As mentioned in the news

To Change Text Font and Style

select: text in any box
go to: the FORMAT menu
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select: FONT
select: font choice

For Rushwritin

select: any shape
double click: upper left corner rectangle, write notes

To View on One Page

from VIEW menu: choose "fit to window"
To See in Outline Format

from VIEW menu: choose outline

To Print on One Page

choose from FILE menu

Notes:

The most recent version of Inspiration will export files in html format. If the
user has Inspiration 4.0, the most recent update is downloadable from the
Inspiration Web site. (www.inspiration.com/updatewin.html)
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Microsoft Word 97 (Win)

Publisher: Retail Cost: $ 339.00

Microsoft Corporation (Headquarters)
One Microsoft Way

Redmond, WA 98052-6399

(800) 426-9400

www.microsoft.com

System Requirements:

Computer with 486 processor or greater

Microsoft Windows 95 or later, and a 1.2 Mb or greater floppy disk drive

Hard drive with at least 8 MB space available and 35 MB for complete
installation

At least 8 MB RAM

VGA Monitor or better resolution

Mouse

CD-ROM drive

Description:

Word is a powerful document processing environment. This version includes
the basic features of several applications users generally think of as separate
from their word processor, e.g., charting with the graph function, graphics
with a draw function, mathematical equation writing with an equation
editor, and built-in spell check, grammar check, and thesaurus.

Recommended Uses:

Word can be used to accomplish nearly every word processing task. This
Windows version adds ease of use to its list of powerful features. For
students with learning or cognitive disabilities, the menus and icons of the
graphical user interface may be more intuitive and thus easier to use. Built-
in interactive spell check, autocorrect, thesaurus, and grammar check should
also help these students. For students with physical disabilities, having an
equation editor and draw function built-in should also prove to be very
useful. Students with mild visual disabilities will benefit from having larger
print available within the program by changing the size of the type or using
the zoom feature. All users will like the extensive on-line help.

Basic Use:

1. Start up Word by choosing it from the Start Menu.
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2. From the Help menu, choose Microsoft Word Help. The paperclip
agent appears with some suggestions.

3. Type a topic of interest into the text field, then click Search. The help
topic or topics the agent thinks you might want to look at are listed.

4. Pick a topic by clicking on it and follow the directions. Many topics
include wizards that walk the user through a tutorial.

Intermediate Use:

Real-Time Spell Check Function
When this option is selected, Word puts a wavy red line under any word not
in its dictionary. The user can right click on an underlined word to see what
list of suggested correct words the program has selected. If the correctly
spelled word is present, clicking on it will automatically cause it to replace
the misspelled word. To turn on this function in Word do the following:

1. From the Tools menu select Options.

2. Click on the Spelling & Grammar tab.

3. Under the Spelling area, check the box next to Check spelling as you

type.

Grammar Checker

The use of a grammar checker may be helpful for students with some prior
knowledge of grammar rules and writing style conventions. However, for
students not able to benefit from grammar checker use, creating a custom
grammar check profile for them is a consideration. It is possible to turn off or
on every feature within the grammar check program. Perhaps only one
grammatical rule could be checked, that of subject-verb agreement. Students
could work in instructor-created text especially constructed to effectively
trigger the grammar checker. This focused activity could have a two-fold
benefit: students could experience a grammar checker working efficiently,
and they might also learn more about subject verb agreement—either from
the activity itself or from actively reading all the Explain screens if their
reading levels allow it.

How to Customize the Grammar Checker

1. From the Tools menu select Options.

2. Click on the Spelling & Grammar Tab.

3. Make sure the Check spelling as you type function is not checked; keep

the use of the Spell Check as a dedicated activity. From the Grammar

section, select the box next to Check grammar as you type.

Click the Settings button to see the grammar checker options.

. Deselect all grammar and style options except Subject-Verb
Agreement.

o s
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6. Click OK.

The grammar checker now has been modified. The next task is to write text
with subject-verb errors which effectively trigger the grammar check rules.

An Auto-Correct Function

When this function is on, Word will automatically correct "adn" to "and" as
the user types. Word comes with many common typing errors entered into
the autocorrect dictionary. It also is very easy to add one's own personal
common typing errors.

Directions for turning on this function and for adding personal choice typing
errors:

1. From the Tools menu, select Autocorrect.

Make sure that Replace Text as You Type is selected

. Enter a frequent typing error into the Replace field, and in the With
field enter a correctly spelled version of the word.

w N

Outline Function

It is useful for some students to work in the outline mode for pre-writing
activities, brainstorming and making a list of related ideas. The outline
function allows topics to be dragged, or moved up or in through the tool bar,
and students can develop a coherent document structure.

To begin Outline mode, go to the View Menu and choose Outline view.
Note the new tool bar. To return to Normal view, go to the View menu and
select Normal.

Customize Menu Options

To create a customized menu environment, it is necessary to create a new
template and save the modifications to it. Directions for creating a new
template follow:

. From the File menu, select New.

Check the Template radio button in the bottom right, then click OK.
Choose Customize from the Tools menu, then dick on the Menus tab.
Select File in the Categories window.

Click on the first option in the Commands window, noting the automatic
action occurring the buttons in the right side of the window. If a
command is currently installed, the Remove button highlights. If a
command is not installed, the Add button highlights. Use those buttons
to add or remove commands.

6. Click other menu categories and make desired changes in the same way.

aAPRON =
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7. Save the file (with no text) with a filename and .dot extension.
8. To use the new template, select New from the file menu. The New
window appears. Double click on the new template.

¢ Use Word Document Templates or Wizards
Microsoft Word comes with many useful document templates. They can be
accessed through the New dialog box. Also accessible from this dialog box

are numerous 'Wizards" which lead the user through customization
processes for different document types.

Notes:
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Middle School Grammar (win cD-ROM )

Publisher: Retail Cost: $ 10.00

Pro One Software
P.O. Box 16317
Las Cruces, NM 88004

System Requirements:
A multimedia PC running Windows 3.1x or Windows 95.
Description:

This is a straight-forward drill and practice collection of activities. The
academic level of the program provides an excellent review of very basic
grammatical understandings. The title is a misnomer; "Introduction to Basic
Grammar" would perhaps have been a more appropriate title. There are self-
help tutorials in 53 subject areas (e.g., verbs (agreement, tense, etc.), and
over 550 practice problems and samples with step-by-step explanations. All
text can be read with JAWS for Windows 2.0 using the JAWS cursor.

Recommended Uses:

This program is useful for any student needing a review of basic grammar
concepts. For students with reading difficulties, use of the screen reader,
JAWS for Windows 2.0, will provide an auditory version of all text.

Basic Use:

1. Open the program from the Program Menu. Set options for sound from
the menu
2. Choose one of the subject areas by moving the highlighted bar to the
desired topic and press Enter. The eight topic areas:
¢ Nouns and Pronouns
e Verbs
¢ Adjectives
¢ Adverbs and Interjections
* Phrases
¢ Clauses and Conjunctions
¢ Agreement
* Punctuation

3. Once a topic has been selected, a sub-table of contents appears. Select the
video option for a brief listing of the topics covered by the content
activities.

4. Select the desired topic.
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5. Begin the lesson. Note that it is possible to go up to the Tool Bar and
take advantage of three different kinds of help: an Example button, the
Worked button which explains the correct answer, and the Details
button which gives in-depth tutorial information about the exact issue
under consideration.

Notes:

The video clip at the end of each major content area is buggy; the user is
unable to input the answer to the one question presented.
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Multimedia Vocabulary (Win CD-ROM)

Publisher: Retail Cost: $ 33.00

Pro One Software

P.O. Box 16317

Las Cruces, NM 88004
1-505-523-6200

System Requirements:

A multimedia PC running Windows 3.1x or Windows 95; CD-ROM drive.
Description:

This drill and practice disk contains over 1,200 vocabulary words which are
usually found on the SAT, GRE, and other standardized tests. In the
majority of the drills, clicking on the vocabulary word causes it to be spoken.

The words are clearly and accurately spoken. It is possible to customize
review sets.

Recommended Uses:

This program is useful for anyone wanting or needing to increase vocabulary
proficiency. The study formats are varied, (scrambled, sentence completion,
multiple choice, matching) providing an interesting range of activities. The
pronunciation of the vocabulary words is excellent.

Basic Use:

1. Launch to program from the Program Menu.
2. Five options appear:
e Verbs
¢ Nouns
* Adjectives
Custom--(design your own test)
* Elements--(study word roots and words derived from them).
3. Select Verbs by clicking on the. One button.
4. A list of presentation styles appears:
* Multiple Choice
One word with four possible definitions. Click on the word to hear it
pronounced.
¢ Matching
Drag the letter of the correct word to its definition. The vocabulary
word is spoken when clicked.
* Sentence
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Click on the button of the correct word.

e Spelling
Like a spelling bee, the word is spoken and the user must type it in.
Click on the Ear button in lower left portion of window to hear word
again.

* Letter Scramble
The user must drag the letters into correct order. Click Solve to have
the program form the word, a useful function for learning.

Notes:
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Omni 3000 1.1.1 (Win)

Publisher: Retail Cost: $ 1995.00

Kurzweil Educational Systems, Inc.
411 Waverley Oaks Road
Waltham, MA 02154

800-894-5374

http:/ /www.krurzweiledu.com

System Requirements:

* Pentium 75 MHz processor

* 16 MB of RAM required, 32MB recommended

* 1 GB hard disk drive

* 1.44 MB 3.5" floppy disk drive

* CD-ROM drive

*  SVGA monitor

* Single-pass color flat-bed scanner, preferably a Hewlett-Packard ScanJet
3p or above

* 16-bit or better sound card

* Microphone, if you wish to use the voice command option

* Full size keyboard with mouse

* Windows 95

Description:

The Omni 3000 is a computer-based reading system that converts printed
material into speech. Users can hear printed words spoken aloud as they
read them on the computer screen. In addition to reading documents, users
can use dictionary and phonetic spelling tools to enhance their reading.
Scanned pages appear on the screen as they appear in the original material.
As the Omni 3000 reads, it highlights each word and its context. The
reading voice, background /foreground colors, and text size are easily
adjustable.

Recommended Uses:

The Omni 3000 was designed for sighted users who have difficulty reading.
It could be used in any setting where students need access to print materials.
It may also serve as a writing environment for users who would benefit from
its special features. Because there are many on-screen controls available, it
is not as suitable as a reading machine for non-sighted students as the
companion product the Omni 1000 which provides easy access for non-
sighted users.
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Basic Use:

1.

2.

Start the Omni 3000. Enter your name if prompted. A window appears
with a number of menus, buttons, and combo boxes.

Run the mouse pointer over the buttons, pausing over each without
clicking and read the tool tips that appear which describe each button's
function.

To scan a document, place it in the scanner and click the Scan button.

. After the image of the document appears on the screen, resize it to your

desired size by choosing a percentage in the Zoom box or by clicking on
the little arrows on the box.

Read the document by clicking on the Play button. Notice the Play
button changes to a Pause button to be clicked when you wish to stop
reading.

To get more information on a word, highlight any word in the document
by double-clicking on it. Click on the Dictionary button in the toolbar.

. Click the Read button to hear the definitions read aloud. To see a list of

words with similar meanings, click Get Synonyms.

Intermediate Use:

1.

2.

3.

Click the right mouse button in the document to see a context menu of
choices to make This method may prove to be quicker.

To select a reading unit, choose from the Read By list box either by word,
by phrase, by sentence, by line, or by paragraph.

To select a reading mode, choose from the Read Mode list box.
Continuous mode will read until you stop it with a mouse click or clicking
on the pause button. If you choose Self-Paced, reading will pause at the
end of whatever reading you have selected.

Notes:
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outSPOKEN (Mac)

Publisher: RetailCost: $495.00

ALVA Access Group, Inc.
5801 Christie Avenue #475
Emeryville, CA 94608
(510) 883-6280

aagi.com

System Requirements:

Macintosh

Description:

At this time, outSPOKEN is the only screen reader for the Macintosh
computer. It reads the Macintosh screen display and provides a keyboard
alternative to the mouse. Several embossed sheets aid the blind user in
understanding the Macintosh screen layout. Instructions also come in
Braille.

Recommended Uses:

Used as a screen reader for persons who are blind, it also is useful for
students with learning disabilities who benefit from auditory text editing.

Basic Use:

1. outSPOKEN is installed in the system folder. Press Command and the
Clear key on the numeric keypad to turn outSPOKEN on or off.

2. Open a file to be read with a word processor.

3. Using the mouse, place the I-Bar at the beginning of the word or line to be
read. Use the following key commands from the numeric keypad.

Basic Commands:

To read a line (I-Bar moves to next) Two (2) key

To read a line (I-Bar does not move) Enter key

To read word at I-Bar, move right Six (6) key

Other Commands:

To move I[-Bar to top of document screen Seven (7) key

To read word, move left Four (4) key

To read one letter, move right Shift Six (6) key
To read one letter, move left Shift Four (4) key

4. It also is possible to read a word by using the mouse to move the I-bar
over the word.
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Notes:
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The Perfect Resume (Mmac/win cD-ROM)

Publisher: Retail Cost: 39.95

Davidson & Associates, Inc.
P.O. Box 2961

Torrance, CA 90509

(800) 545-7677

http:/ /www.davd.com/

System Requirements:

This hybrid CD ROM will work with Windows 95, Windows 3.1, and the
Macintosh operating system. Minimum requirements for the three platforms
follow:

Windows 95:  256-color Super VGA graphics, 8 MB RAM, a Pentium
machine, double speed CD-ROM with hard drive with at least 6 MB free
space; Mouse and printer, Windows-compatible sound card.

Windows 3.1: 256-color Super VGA graphics, 4 MB RAM, 33 MHz 386DX
or faster, double speed CD-ROM, Hard drive with at least 6 MB free, Mouse
and printer, Windows compatible sound card.

Macintosh: System 7.0 or higher, LC II machine or higher with 256 color
system, 4 MB RAM, double speed CD-ROM,, hard drive with at least 6 MB
free, printer.

Description:

This resume creator, designed by a professional, is a tool for a job seeker to
easily create a number of resumes as well as keep track of the job application
process. The theory behind the program is that each job application must
have a resume which exactly provides information relevant to that particular
job. The program incorporates context-sensitive advice from an expert
consultant in multimedia format.

Tom Jackson's career development advice is the backbone of The Perfect
Resume The video clips of his tips, suggestions, and guidance are organized
in extensive help files throughout the program. Whether the issue is deciding
what kind of resume would work best, looking for an action word to describe
an accomplishment, or drafting a follow-up letter to an interview, Tom
Jackson is there to guide the user. The advice is concise and presented in a
very understandable manner.
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Recommended Uses:

This program could be a useful tool for any student who would benefit being
guided through resume development. The multimedia information provides
a rich learning environment for students with learning disabilities who
would be unable to read written advice or have the patience to attempt to
read about strategies for getting a job or developing a resume. The
multimedia portion might also be helpful for ESL students: the video clips
contain material which could help with the acculturation process.

Basic Use:

1. Open The Perfect Resume by selecting it from the Windows 95 program
menu. After the program has loaded, the user can select to go to one of
the three major components of the program: Resume Builder, Power
Letters, or Job Search Manager.

2. In order to understand how the resume shell structure works, select

Resume Builder.

. Select Chronological from the resume type list.

Maximize the Resume Builder application by clicking on the maximize

button in the top right corner area of title bar.

5. Click on first data area to be filled in. Click on rectangle to trigger data
screen.

6. Click the Expert button at any time for more information. Information
may or may not include video clips.

7. Fill in required information.

8. Follow instructions to completion.

AW

To View Multimedia Sections Only:.

1. From the Main Menu, select Help.
2. Select Expert Contents from the Help Menu.
3. Select Video Resume Consultant from the Help Links.

Notes:
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SkillsBank 4 (win )

Publisher: Retail Cost: $1,245.00

Skills Bank Corporation
Park View Center 1
7104 Ambassador Road
Baltimore, MD 21244
(800) 451-5726
www.skillsbank.com

System Requirements:

Skills Bank 4 will work in Windows 3.1, Windows 95, NT; purchasable as a
single-user CD, 5-user lab pack, or as a network version (SO-user or
unlimited in one building).

Description:

Skills Bank 4 is an all-new version of the basic SkillsBank 3 program. The
activities are the same, but the format is different. The program now comes
on CD ROM only. Critical thinking strands are incorporated throughout
each subject area. The 200 plus topics are contained in 19 subject areas. The
program comes contains these basic content areas: reading, language,

writing, basic mathematics, intermediate mathematics, and information
skills.

Recommended Uses:

Skills Bank software is useful for any student needing a brief, basic tutorial
review in major basic skills areas. This new version comes with a
complement of in-depth activities which can be purchased. There are two
Practice series and a MathCheck starter kit currently available.

Major Components:

Diagnostic and prescriptive pre-tests
Basic skills lessons

Quizzes

Thinking skill lessons

New Features

* Voice and sound guide students through lessons and provide an extra
modality for learning

* Lessons on Internet fundamentals are included.
* Mathematics activities have been revised and there are 40 new activities.
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Purchasable Language Practice Series provides 22 add-on lessons with
open-ended interactive practice on all concepts in SkillsBank Language
Series.

Purchasable Computation Practice Series features 24 add-on lessons with
randomly generated problems in an open-ended interactive setting.
Enhanced teacher reports

Purchasable mathematics worksheet generator (MathCheck) which offers
add-on libraries of additional math content.

Notes:
Pricing:
Single User Set (Basic Skills) $1245.00
5-User Lab Pack $2490.00
50-User Net Site $4980.00
Unlimited Net Site $7470.00
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Spellbound (Mac/win cD)

Publisher: Retail Cost: $ 29.95

The Learning Company
6493 Kaiser Drive
Fremont, CA 94555
1-510-796-3030

http:/ /www.learningco.com/

System Requirements:

Multimedia PC with CD-ROM drive; Windows 3.1 or Windows 95; Macintosh
version runs on all color Macintosh computers, including Color Classic, Color
Classic II; LC series (except original LC); II series (except II); color
PowerBook series; Centris series; Quadra series; Quadra AV series; Performa
series (except Performa 200); and Power Macintosh series.

Description:

This spelling program, although ostensibly designed for children, provides
useful activities requires visual discrimination, visual and auditory word
recognition, word recall, concentration and problem solving.

Recommended Uses:

For students needing to practice spelling skills, finding different types of drill
material may provide students with added incentives for practice. In this
particular software, different learning styles can be accommodated during
certain phases of the interactive spelling drill program. In some areas of the
program activity, it is possible to ask for auditory information rather than
visual information. It also is very easy to add words to the vocabulary lists.

Basic Use:

1. Start up the program by selecting it from the Program Menu.

2. Enter name when prompted. Click when finished. The Vocabulary screen
appears.

3. Move the highlight bar through the list with the Down Arrow key. Note
that words in the list appear in the right hand side of the screen.

4. Double-click on a list name to select it and automatically move to the
begin game screen.

5. Select a spelling activity from the Spellbinder screen. Note that it is
possible to choose from three: Word Search, Crossword, or Flash
Card modes. The fourth option, Spelling Bee can be chosen only when
the user has accumulated a specified number of points--an incentive to
encourage the user to keep working.

How to Add a Customized Vocabulary List
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1. Open the Word Manager screen by selecting it from the File Menu.

2. Click on My Topic.

3. Double click on Create List.

4. When the empty word list screen appears, give the vocabulary list a
name. Add words.

5. Double Click on Done when through to go back to the Word Manager
screen.

6. In order to use the list just made, it is necessary to do the following:

7. Click on My Topics to see what word lists appear. Move all word lists

associated with My Topics below the End bar except for the one just
made.

8. To move a word list, double click on it to select it; it turns blue and yellow.
Drag this selected item below the End line. Double click on the item to
de-select it. Repeat the process as necessary.

Notes:
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Story Book Weaver Classic Edition(win cp)

Publisher: Retail Cost: $ 12.95

SoftKey International Inc.
One Athenaeum Street
Cambridge, MA 02142
1-800-845-8692
http://www.softkey.com/

System Requirements:
Multimedia PC running Windows 3.1 or higher.
Description:

This basic desktop writing environment lets the user construct stories with

background scenes, characters and music and sounds. Working in Windows
95, sounds could not be added, although music could be added. It is possible
to purchase this over the Internet from the SoftKey CD Outlet

Recommended Uses:

Because this is so easy to use, the program can provide a non-threatening,

fun environment for someone just beginning to develop or improve writing
skills.

Basic Use:

. Open the program by selecting it from the Program Menu.

Click on the blank open book to write a story.

It is possible to select from beginning ideas or to begin one's own.

Select New. The title page construction screen appears. The tool bar

along the left margin has tools to make Title, Author and Comment fields

on the title page. Then there is a Border tool.

5. Click on the Title button and fill in the text field.

6 Click on the Author button and fill in the text field

7. Click on the Comment button if comments are desired.

8. Click on the Border button and select a title page border. Click Done
when through.

9. Click on the Right Arrow at the bottom center of the screen to move to the
next page.

10.Select the Background button and add one or two panels for page
graphics.

11.Select the Object button if persons or objects are to be added to the scene.
Click Done when through.

12.Move to the text field on the page and begin writing text.

13. Click the Right Arrow at bottom center of screen to move to next page.

Ao
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14. Save work; print work.

Notes:
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Student Writing Center (win)

Publisher: Retail Cost: $ 42.95

Softkey International
(The Learning Company)
6493 Kaiser Drive
Fremont, CA 94555

(800) 852-2255
www.softkey.com
www.learningco.com

System Requirements:

Windows 3.1 or Windows 95; at least a 486 processor or better; VGA display
or better; 4 MB of RAM; 8 MB hard disk space; will support color printer.

Description:

This is a desktop publishing productivity tool for the creation and generation
of different types of documents: reports, newsletters, journal entries, letters,
and signs. The program comes with an extensive library of clip art,
letterheads and sign borders.

Recommended Uses:

This easy-to-use program provides a basic introduction to the processes
involved in desktop publishing. The basic word-processing attributes of the
program are similar to Microsoft Word, allowing students to learn skills to
take to Microsoft Word, or students' familiarity with Microsoft Word will
allow them easy access to the functions provided by this program. A unique
feature of the program is its ability to allow students to create generic types
of bibliographic entries. Students fill in dialog boxes and the program
converts the information to an acceptably punctuated bibliographic format.

Basic Use:

1. From the Program Manager, double click on the Writing Tools Program
Group and then double click on the Student Writing Center.

2. Click on one of the document types.

3. Click on the Tips button located on the Tool Bar which runs across the
top of the document.

4. Explore the Tips section for that document type. Close the document by

;‘lic):king on the File menu and selecting Close (or use the hot key Ctrl

Click the New button on the Tool Bar and select another document type.

Explore this document style by following steps two through four.

o o
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Intermediate Use:

Make a document. There are four document types to choose from:

* Report
Create essays, research papers, book reports or stories. This section has the
bibliographic tool.

* Newsletter

Create multiple-column documents. Insert graphic elements (supports .wmf,
-pcx and .bmp file formats) and text wrap occurs. Layout elements include
masthead and multiple column options.

¢ Journal
The current date is automatically placed at the top of a new file; a password
may be set to keep journal private.

e Letter
Create social or business letters; create letters with letterheads; resize Tips
text and use this hypertext help to create a letter type.

e Sign
Create announcements, flyers, award certificates. Use a color printer for
special effects.

Notes:

There are some age-inappropriate sample letters in the Letter Tips section.
There is a spell check function which may be used with all documents.
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Student Writing & Research Center(win)

Publisher: Retail Cost: $ 56.95

Softkey International
(The Learning Company)
6493 Kaiser Drive
Fremont, CA 94555

(800) 852-2255
www.softkey.com
www.learningco.com

System Requirements:

Windows 3.1 or Windows 95; at least a 486 processor or better; VGA display
or better; 4 MB of RAM; 8 MB hard disk space; will support color printer. A
Windows-compatible sound card is required to support the multimedia
functions of the encyclopedia.

Description:

Student Writing & Research Center combines and integrates Student
Writing Center and Compton's Concise Encyclopedia to make writing
high-quality, thoroughly-researched, and well-referenced reports easier and
more exciting than ever. Student Writing Center, as a stand-alone, is a
desktop publishing productivity tool for the creation and generation of
different types of documents: reports, newsletters, journal entries, letters,
and signs. The program comes with an extensive library of clip art,
letterheads and sign borders.

While writing a report in Student Writing Center, students can click on
the research icon to bring up a complete 25-volume encyclopedia, 8,000
pictures, more than 75 videos and multimedia presentations, an atlas,
timelines, and a dictionary. To take notes or add to their report, students can
simply highlight, copy, and paste text and pictures into a Student Writing
Center document. The citations and bibliography entries will be added and
formatted automatically.

Recommended Uses:

This easy-to-use program provides a basic introduction to the processes
involved in writing a research paper and desktop publishing. The basic
word-processing attributes of the program are similar to Microsoft Word,
allowing students to learn skills to take to Microsoft Word, or students'
familiarity with Microsoft Word will allow them easy access to the functions
provided by this program. A unique feature of the program is its ability to
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allow students to create generic types of bibliographic entries. Students fill
in dialog boxes and the program converts the information to an acceptably
punctuated bibliographic format. Students can copy material (text, images)
from the encyclopedia, or they can paraphrase basic content areas and cite
the reference source. This software application could be used for research-
paper-creation by students who find it difficult to get to a school library

Basic Use:

1. From the Program Manager, double click on the Writing Tools Program
Group and then double click on the Student Writing Center.

2. Click on one of the document types.

3. Click on the Tips button located on the Tool Bar which runs across the
top of the document.

4. Explore the Tips section for that document type. Close the document by
clicking on the File menu and selecting Close (or use the hot key Ctrl
F4).

5. Click the New button on the Tool Bar and select another document type.

6. Explore this document style by following steps two through four.

Using Compton's Concise Encyclopedia

1. Click on the Research button on the Tool Bar of the document window.
Compton's Concise Encyclopedia loads.

2. Explore the functions of the Tool Bar which runs the length of the left
margin. As different options of this tool bar are selected, the small
windows occupying the rest of the screen change content: text appears in
the right half of the screen; the left half of the screen has two windows,
one in which graphic images appear, and one in which content searches
can be made.

3. Each of the smaller windows has tool buttons in the lower right corner.
The content of these buttons varies from context to context, but always
available is a Full Screen button which enlarges the window to full
screen display. The user can always return to the multiple window
display by clicking on the Small Screen button in the full screen display.

Intermediate Use:

In addition to encyclopedia use, this software program supports all the
writing functions available in the stand-alone version of the Student
Writing Center:

* Report
Create essays, research papers, book reports or stories. This section has the

bibliographic tool.

¢ Newsletter
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Create multiple-column documents. Insert graphic elements (supports .wmf,
.pcx and .bmp file formats) and text wrap occurs. Layout elements include
masthead and multiple column options.

e Journal

The current date is automatically placed at the top of a new file; a password
may be set to keep journal private.

e Letter

Create social or business letters; create letters with letterheads; resize Tips
text and use this hypertext help to create a letter type.

* Sign
Create announcements, flyers, award certificates. Use a color printer for
special effects.

Notes:

The following was cut and pasted from the Help section of the encyclopedia
by selecting Copy from the main menu, selecting the text, and then pasting
the text into a document.

Tableau and Viewers

When you open Compton's Concise Encyclopedia, you see the tableau screen,
which frames the four main components of Compton's environment: the path
bar that runs down the left edge of the screen, the multimedia viewer in the
top left, the article viewer on the right, and the path viewer on the bottom
left. The path bar displays the main avenues or "paths" into the
encyclopedia's storehouse of information. See the descriptions in this guide
for details on how to use each path.

THE PICTURE VIEWER offers pictures in two sizes: the actual picture size
and a size that fits within the current window. To view the picture at the
largest size available, click on Full Screen and adjust the size to the larger
view. Click on Article to see the article that corresponds to the picture. If the
cursor changes to a hand holding a handle when you move it over a picture,
click and drag to move other parts of the picture into view. Or click on Size
or Full Screen to see the entire picture.

THE MULTIMEDIA VIEWERS--which display videos, slide shows,
animations and sounds--have the same kinds of controls as your VCR or
cassette player, with the addition of the Rewind to the Beginning button that
lets you return to the beginning of a clip instantly. In the video, slide show
and animation viewers, click on Size and hold down the mouse button to

Writing Tools Page 47



select a playback size. At the maximum size, click anywhere to stop the
playback.

THE TABLE VIEWER offers a Lock/Unlock Title "toggle" button so you can
freeze the first row and column of a table into place. When the titles are
locked, column and row headings stay in view while you use the scroll bars to
see the rest of the text in the table. The label on "toggle" buttons always
shows the available option--not the option that is active. So when the button
says Unlock Title, clicking it will unlock the titles so they will move with the
rest of the rows and columns.

Other toggle buttons include Full/Small Screen in all viewers and .S./World
and Detail/Outline in the Timeline path.

THE ARTICLE VIEWER is the largest of the viewers in the tableau. Here
you'll see the text of articles and the icons and cross-references that lead to
multimedia and other articles. Use the buttons along the bottom to navigate
and manipulate the article text and the viewer. Purple text represents cross-
references to other articles in the encyclopedia. Double-click on a purple title
to see an article related to the one on screen. To return to the article you
were viewing, just click on Backtrack.

Highlight a date in the text of an article and click on the TIMELINE path to
see what other events happened in the world at that time. If you encounter a
word you don't know while reading an article, double-click on it to see its
definition. You can even double-click on another word in a definition to learn
its meaning. Double-clicking on any word in any article or caption text leads
you to the dictionary.

In the small screen mode, the DICTIONARY AND THESAURUS VIEWER is
very simple to use. Double-click on a word in an article or caption to see its
definition, or open the dictionary from the path bar, type the word you want
defined, and press Enter. In the full screen view, the viewer also features a
scrolling list of words to choose from and an alphabetical position bar with a
movable selector. Click and drag the selector to move quickly to another part
of the dictionary.

OUTLINE displays a list of the article contents including text, multimedia
and cross-references. When you select Outline, the article outline appears in
the bottom left corner of the tableau. Click on the media selection buttons at
the top of the outline viewer to choose the type of list you want to see.

Double-click on items preceded by multimedia icons to learn more about the
subject of the article. These items are displayed in the multimedia viewer.
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Listings without icons indicate subsections of the article. Double-clicking on
a subsection title displays that section of the article in the article viewer.

OPTIONS offers several useful features. Click on Options and hold down the
mouse button to see the list of option features. While still holding the mouse
button, drag the cursor to highlight the option you want and release the
mouse button. Select Bookmark List to see a list of the bookmarks you have
placed. Double-click on a bookmark name to go to it. Select Research
History to see a list of the articles and multimedia you have opened in your
recent explorations through the encyclopedia. Double-click on an item to
return to it. Highlight the text you want and select Copy to Idea Search to
copy the selected text to the Idea Search path. While holding down the
mouse button, highlight Font Size to see a selection of text sizes. Move the
cursor to highlight the size you want and release the mouse button. The
article text will change to the size you selected.

Select Find a Word, Find Next, or Find Search Highlight to find the next
instance of a specific word. If you selected the article from an Idea Search,
Find Search Highlight will find the next instance of a keyword from your
latest search request.
COPY copies any text you have selected to the Windows clipboard.
PRINT prints the text of the current article.
BOOKMARK places a bookmark in the current section of the article. If you
want to create a bookmark for only part of an article, place the sentence or
paragraph from where you wish to begin at the top of the window. Your
bookmark will be created from that point in the article.
FULL SCREEN enlarges the article viewer to full-screen size.

Works Cited *
"Encyclopedia Help." Compton's Concise Encyclopedia. 1995.

(This reference created by the bibliographic tool.)
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TextAssIst (win 3.x/95)

Publisher: Retail Cost: $ Included w/ Card

Creative Labs, Inc.
1901 McCarthy Boulevard
Milpitas, CA 95035

System Requirements:

A Sound Blaster card that supports TextAssist, 386SX-25 w/ 4MB RAM, 2
MB hard disk space, Windows 3.x or Windows 95.

Description:

The TextAssist TextReader provides high quality speech output for selected
text. Options to change the volume, rate, and pitch of the current
TextReader voices are accessible via the TextReader button bar or the
System menu. The speech is customizable to the voices of the familiar
DECtalk speech synthesizers.

Recommended Uses:

The TextReader application can serve as a proofreader for any user, but is
especially useful for those who have difficulty reading.

Basic Use:

1. To launch the Text Assist TextReader, double click on the icon( Win 3.x);
in Windows 95, select Programs, SoundBlaster, and then Text
Reader. A button bar appears on the screen. This bar controls the flow
of speech similar to a tape player controls. The right arrow is the
play/stop button and the button to its right is the pause/resume button.
Clicking the larger rectangle against the right end of the button bar
activates the volume and rate slider bar, clicking on the small rectangle
against the right end of the button bar closes the Text Reader application.
Start an application or file containing text to be read.
. Highlight the portion of the text to be read by selecting the it with the
mouse.
4. Click on the Play button of the button bar to hear the text spoken. If no
text is highlighted, clicking the start button will cause TextReader to read
the entire document.

w N

Notes:

In Windows 3.x it is possible to have a text file read in File Manager by
dragging the file icon up to the TextReader button bar.
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In Windows 95, it is possible to do the same from Windows Explorer.
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textHelp! ver 2.10 (Win)

Publisher: Retail Cost: $ 250.00

Lorien Systems
Enkalon Business Part
25 Randalstown Road
Antrim

Co. Antrim

Northern Ireland

BT41 41LJ

(44) 0 1849 428574 (Fax)
U.S. contact (800) 747-0429
sales@loriens.com
support@loriens.com

System Requirements:

Windows 3.1x; at least at 386DX processor running at 33 MHz; 4 MB RAM,
although 8 is recommended; up to 16 MB free disk space before installation;
a Sound Blaster compatible sound card.

Description:

This software program provides students with learning disabilities and
dyslexia with specialized tools to make the writing and reading process
easier. textHelp! is a free-standing utility which works with other
applications. The program speaks text as it be being typed, performs real
time spell checking, can suggest phonetically close spellings, will
automatically correct words, will support a small magnified viewing area,
and provides automatic word prediction as a person types. Although in
actual practice any one student generally will only use a few of these
features, they all will work together.

Lorien Systems also sells an institutional site license (e.g., $9,000 for 15,000
users) and all users (staff and students) are free to copy the program

Recommended Uses:

This program is recommended for students who have difficulty spelling,
difficulty in reading what they have written, or who have poor recognition
ability in differentiating between homonyms. Additionally some students
with mild visual disability may benefit from the limited ability of the
program to magnify small areas of text, and students with orthopedic
difficulties who are unable to key in text rapidly may benefit from using this
program.
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Basic Use:

Starting the Program
1. From the Program Manager Icon, double -click on the textHelp! icon.

The program (in default usage) puts up a blank word suggestion box.
2. Start a word processing program: e.g., Word for Windows or Write.

3. Depending upon its settings, textHELP! will appear as a small window on
top of the document screen or as a small toolbar positioned in the title bar
of the major application.

4. The following basic functions can be accessed by hot keys:

Displa¥ the Main Menu

It is possible to display the main menu by pressing Alt-Ctrl-M. When the
tool bar is displayed, it is also possible to click on the Menu button (the last
button on the right) to bring up the main menu.

Toggle Word Prediction
Pressing Alt-Ctrl-P starts or stops the word prediction function. When the

function is invoked, the toolbar moves to the word prediction panel which is
positioned on top of the document window.

Using the word prediction function is very easy: watch the panel as keys are
entered, enter the number of the word when it appears in the word prediction
panel. Press the Spacebar after the word has been entered. The word will be
spoken if the speech option has been set up to include word echo.

Toggle Real Time Spell Check
The command Alt-Ctrl-S starts and stops the ability of textHelp! to monitor

keystrokes as they are entered. If the program detects a word not in its
dictionary, or a misspelled word, a spell check window appears on the screen.

In order to bring up suggested word list, enter Alt-G or click on the Suggest
button. Move the highlight through the words, pressing Alt-S or clicking or
the Speak button to have the word pronounced. Tapping Enter when the
highlight bar is on the desired word replaces the misspelled word with the
correctly spelled word. The command Alt-R will do the same thing.

Speak Selected Text
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Entering Alt-Ctrl-V causes textHelp! to read any text which has been
selected. The only way to stop the speech is to select Stop Speech from the
main menu (Alt-Ctrl-M).

Toeele the Magnification Function (the Zoomer)

The command Alt-Ctrl-Z turns on and off the textHelp! magnification
function. It also is possible to control the magnification function from the
main menu.

Temporarily Stop All Text Help Functions
The hotkey combination Alt-Ctrl-X stops textHelp! from processing any

keystrokes (However, it will not stop speech already in progress; only the
Stop Speech selection from the main menu will do that).

Notes:
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Typing Tutor 7 (Mac /Win CD-ROM)

Publisher: Retail Cost: $ 49.95
Davidson & Associates, Inc./Simon & Schuster, Inc.
P.O. Box 2961

Torrance, CA 90509
(800) 545-7677
www.davd.com

System Requirements:

The same disc may be used in a Macintosh or Windows computer.

For PC:

At least a 486 MHz processor with 8 MB RAM; Sound Blaster-compatible
multimedia sound card; hard disk with 1 MB free space; at least a 2x CD-
ROM drive; Windows 3.1x or Windows 95.

For Mac:
A Power PC or at least an 040 processor with 8 MB RAM; monitor with
640x480 display area; 256-color capacity; at least a 2x CD-ROM drive.

Description:

This multimedia typing tutor evaluates strengths and weaknesses of the
typist and then creates customized lessons based on the typist's individual
needs. A novel addition is the inclusion of practice sample writings taken
from over 100 well-known books. Learning is made fun with video clips
which run as a reward after the completion of certain typing tasks. Excellent
statistics are kept by the program.

Recommended Uses:

This Davidson product is recommended for any individual desiring to learn
or improve typing skills. The program incorporates some newer features:
e.g., typing drill embedded in the construction of particular letter types, and
provides real-time practice on useful activities.

Basic Use:

For Mac or PC:
1. Double click on the Typing Tutor 7 icon.
2. Register and take an assessment test, or enter the program as a visitor.

3. Follow the lessons suggested by the program, or randomly explore the
program as a visitor.
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Major Program Components

¢ Keys to Success

Once a practice typing test has been taken, a personalized lesson containing
words and sentences is created. Lessons, games and tests are available in
QWERTY, two-handed Dvorak, and 10 key setups.

¢ Chart Your Progress
Asses progress with eye-catching, printable graphs after completing time-
monitored speed tests.

¢ Practice Makes Perfect
Sharpen typing skills with practice samples from over 100 well-known books,
including everything from fiction and biography to sports and humor

e It's Showtime

Practice typing with 100 text excerpts then rewards the typist with a video
clip related to the subject chosen for typing drills.

e Arcade-Style Games

Rescue cities from alien letters and words; solve hidden word mysteries; race
against the clock.

Notes:
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Ultimate Word Attack (Win/Mac CD))

Publisher: Retail Cost: $ 29.95

Davidson & Associates, Inc.
P.O. Box 2961

Torrance, CA 90509

(800) 545-7677

System Requirements:

Multimedia PC with 5 MB free space; Windows 3.1 or 95; 8 MB RAM.
Macintosh: LC III or Power PC with 5 MB free space; System 7.1 or higher.

Description:

Ultimate Word Attack is a versatile, economical program for spelling drill.
This version has 2 CDs and is a hybrid set, meaning that for the same price,
you get CDs that will run on a Mac or PC. The activities are the same as
those in Word Attack 3, but the presentation and graphics have changed.
The vocabulary lists are extensive, and well organized by and within
category.

In addition to a presentation activity, there are four activities:
* a tile game where definitions must match an exposed tile
* a crossword puzzle game which uses fill-in the sentence blank or
definitions as clues
* a maze game with an arcade-type format
* a hat game with an arcade-type format

Record keeping activities and an easy-to-use authoring component are
included.

Recommended Uses:

Recommended for students who wish to work on vocabulary development.
Both reading and spelling activities are included in response formats.

Basic Use:

The Main Menu
There are four basic menus:
* the File menu which accesses student records or authoring activities;
* the Word List menu which controls word list level and the ability to
view an entire word list;
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* the Activity menu which controls such basic functions as speech,
sound, starting and stopping, options;

* the Help menu which provides access to on-screen instructions or on-
screen hints.

Program Activities:

Presentation Activity

Begin with this activity in order to familiarize the student with the
vocabulary list. If a speech device is included, each word will be spoken as it
is introduced visually. There are three levels of difficulty to work in: Study,
a passive, activity; Solve, an activity requiring the user to enter target word
from the keyboard (target word is displayed); or Complete the Sentence
(user must type in the word from memory).

Tile Activity

The user is challenged to clear the tiles off the screen by matching each word
with its definition. The definitions for the words are displayed below the
tiles. If one of the words on screen does not match the definition, use the
arrows to scroll through the definitions until you are able to make a correct
match. A match clears a tile from the screen and uncovers the tile beneath it.
Clear all the tiles to win. Double click on a tile to select it.

Crossword Puzzle

In this activity, match each word with its clue. If the highlighted letter box is
shared by two words, two clues will appear: one for the across word and one
for the down word. To move from word to word, use Tab, arrow keys or click
the letter box with the mouse. There three modes of play: clues can be
Definitions, Sentences or Mixed--a combination of clues in definition or
sentence form

Maze Game

Move the Mascot Character (M.C.) through the vertical maze before time
runs out. This character is to be moved through the maze so that he can eat
the word which has its definition displayed at the bottom of the screen. The
player needs to figure which word is accessible and then must select its
definition (by rotating through the definition list) before the character can be
moved to gobble the target word.

Slime Game

This is an arcade-type activity. The object is to help the M.C. throw balls at
the word that matches each definition that appears at the bottom of the
screen. To play, look at the definition at the bottom of the screen; click at the
correct word or use the up or down arrow to move the M.C. directly across
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from the word and then press Spacebar. If the word is correct, a slime
creature falls from the pipe. The pace of the game is controlled by choosing
Easy, Medium, or Hard level of difficulty at the beginning of the game.

Editor

The Editor, an easy-to-use authoring tool, allows the user to make new word
lists. It is possible to select words already included in the program or to
input new words. It is necessary to provide a definition and two sentences in
which the word is used. Give the file a name when it is saved. To use this
word list, select custom from the Word List menu, and select from the file
names displayed.

Stopping
Go to the Activity Menu at the top of the screen and select Stop. Selecting
Quit from the File Menu will exit the program.

An Add-On

There is a companion audio CD with 25 vocabulary lists of 11 words each.
Each word is spoken, a definition is given and then the word is used in a
sentence. Voices alternate from female to male. The words are not a part of
the software game, but are listed in the documentation folder. The auditory
information could be transcribed into the editor if one wished to use words
from the audio CD. This disc could also be used for vocabulary enhancement
while commuting.

Notes:
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Word Munchers Deluxe (win 3.x, 95/Mac cD)

Publisher: Retail Cost: $ 14.95

MECC

6160 Summit Drive North
Minneapolis, MN 55430-4003
612-569-1500
http://www.mecc.com/

System Requirements:

This disc supports the Macintosh, and Windows 3.x and 95.

* Specific requirements for the Windows 3.x version: 486/50MHz or higher,
256 SVGA color display, 4 MB RAM, although 8 recommended, double-
speed CD-ROM, mouse, and sound card.

* Specific requirements for the Windows 95 version: 486/50 MHz or higher,
256 color SVGA display, double-speed CD-ROM, 8 MB RAM, mouse,
sound card.

* Specific requirements for the Macintosh: 68040 or higher (Performa 575
or greater), System 7.1 or later, 5 MB RAM (8 recommended), double-
speed CD-ROM.

Description:

This program is an expanded version of the original Word Munchers grid
game which required students to select words containing a target vowel
sound. This model has been increased to include word selection activities
related to linguistic elements and tasks. The program is designed for use
with a range of ages, and allows the user to choose whether or not to play
with "Troggles" (cartoon creatures which chase the player if play is moving
too slowly).

The game materials are organized by grade level: grades one through five.
The use of "grade level" as the reference for game structure is unfortunate,
for the stimulus materials are presented in a relative grade-free manner. For
older learners, the term "level one," rather than "grade one" would have been
more appropriate.

It is possible to control sound and music options from the menu bar. The
only way to stop a game is from the File option on the menu bar.

Recommended Uses:
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This program may be useful in facilitating automaticity in the
decoding/encoding processes of reading and writing. The small cost of this
disc, coupled with its range of linguistic activities structured in the long-
popular Word Munchers format, make it a useful addition to a software
library. Some activities requiring students to match sounds to objects
pictured may be difficult for some persons with visual perceptual difficulties

Basic Use:

1.
2.

3.

Double-click on the Word Munchers icon.

Select Play Troggle-Free and the program will open to the main
menu.

Select the level of play desired by clicking on the appropriate tab.
Select the game content and subject matter by clicking one the topics
listed on the left page of the main menu graphic; select or de-select the
desired stimulus materials from the right page by clicking the check
boxes.

Decide whether to have stimulus material topics presented in the
order listed or in random fashion by clicking the In Order/Random
toggle button at bottom of the right page.

Click on the Play button at the lower right corner of the screen to
begin current game. Important: one must double-click a correct item
before it is selected.

The current game will automatically end when all of the correct items
have been selected.

To exit a game in progress, go to the File menu and select New
Game.

Program Content

Grades One and Two: Classification: color, shape, design, class;
Grammar: naming words, action words, describing words; Phonics:
initial consonants, final consonants, vowels; Vocabulary: rhyming
words; Sentences: naming words, action words, describing words; and
Challenge: a random presentation of activity.

Grades Three and Four: Grammar: nouns, action words, adjectives,
pronouns, adverbs; Phonics: vowels; Vocabulary: synonyms,
antonyms; Sentences: nouns, action verbs, adjectives, pronouns,
adverbs; and the Challenge activity.

Grade Five: Identical to structure of levels Three and Four with the
exception of the following: Grammar and Sentences contain the
additional stimulus topics of prepositions and interjections.
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Writer's Helper (win)

Publisher: Retail Cost: $135.00

Prentice Hall

P.O. Box 11071

Des Moines, IA 50336-1071
(800) 842-2958
www.prenhall.com

System Requirements:
Writer's Helper will run in Window 3.x or Windows 95 computers.
Description:

Writer's Helper is a collection of programs to help writers find and creatively
organize ideas, put ideas in writing and evaluate what has been written.
Writer's Helper offers an approach to introducing word processing as a tool
for writing and language arts to a beginner. Writer's Helper allows students
to create a file, save the file to disk and then load it into another word
processing program for editing or formatting changes. Then the student may
re-enter Writer's Helper with the file to use the revising tools.

Recommended Uses:

This program is useful for all students needing assistance in developing
writing skills. A number of state colleges use the program in remedial
English classes.

For students with learning disabilities, the program provides structured
ways to work on very specific components of the writing process. The
program provides activities which:

1. Desensitize students to the writing process and writer's block (free-
writing activities).

2. Improve and expand upon a student's creative writing skills and to help
a student develop ideas.

3. Develop strategies and practice categorization and organizational skills
(trees).

4. Improve spelling strategies through categorization of spelling rules

(trees).

Improve comprehension of a passage by categorizing information (trees).

Develop strategies for distinguishing similarities and differences

(comparing and contrasting).

oo
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7. Improve analytical skills by viewing information from both sides of the
issue (debating an issue).

8. Develop writing skills and strategies for creative writing (five paragraph
theme).

The files created by Writer's Helper are designed to be compatible with
several word processing programs including WordPerfect. Because the files
are compatible with a major word processor, a student may create the germ
of the document with Writer's Helper, and write the paper in a supportive
writing environment (word processor, on-line spell check, and thesaurus).
The student can return to Writer's Helper to run the rough draft of the essay
or report through the revising tools. The student then does final editing of
the document in a standard word processor.

Basic Use:

This menu driven program is easy to use, and on-screen prompts and context
sensitive help are always available. The student moves a highlighted bar
across the Main Menu Line to select PreWriting Tools or Revising Tools. A
new menu appears across the menu line. From this menu the student
chooses the particular activity desired (e.g., Find, Explore, or Organize in
PreWriting Tools; Structure, Audience, Checks in Revising Tools). A drop-
down menu appears under each topic. Because each program screen is well-
labeled, users always know what task they are working on.

Intermediate Use:

Writer's Helper is a set of tools to use with the prewriting and revising
components of the writing process. If the Notepad function of the program is
used, its dedicated word processor will allow a student to create an entire
document in Writer's Helper. PreWriting Tools are designed to help the
writer Find a subject, Explore a subject, and Organize information about a
subject. The Revising Tools are divided into three categories of analysis:
Structure, which proofreads the document; Audience, which evaluates the
document in light of the intended audience, and Checks which searches for
word errors.

Prewriting Tools:

FIND Tool

. Starters
Idea Wheel
Associations
Questioner
Lists

NhLON =
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6. Brainstorms
EXPLORE Tool

. Crazy Contrasts
Three Ways of Seeing
Audience

Random Revelations
Connections

Teacher

QAR ONM

ORGANIZE Tool

1. Trees
List eight items related to topic.

2. Debating an Issue
List three statements supporting topic position.

3. Structure Guide
This important feature provides outline structure for nine different types
of academic reports:

Biology

Chemistry

Clinical Psychology

Economics

Education

History

Physics

Scientific

i. Sociology

4. Goals
Add two purpose statements to stimulus list given.

5. Compare/Contrast
Compare a similar, more familiar object or subject and list three ways in
which they are similar.

6. Outline
Provides a simple outline utility.

7. Develop a Paragraph
This tool leads the writer through the development of a descriptive or
argumentative paragraph. An example of the prompts which precede the
tasks for student writing is listed below. From this example, a student
can observe and infer the nature of paragraph structure. The student is
then asked to state an assertion about a topic and then must write four
sentences of proof to support the assertion. This Develop a Paragraph
exercise is a powerful tool because students are prompted through a
process of learning about and understanding the structure of paragraphs.

FR™me a0 o
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8. Five Paragraph Theme
This unit leads students through the construction of a five paragraph
theme. Because the form of an essay depends on the purpose of the
writer, students must first select an appropriate purpose for the essay
from a selection of five choices: Describe, Compare, Show how ... has
changed over time, Describe the job or function of.... | and describe the
importance of.... In this exercise, students are asked to type a word or
phrase naming the intended audience of the paper, then to write three
sentences which support the purpose (written for a friendly or negative
audience) of the document. These sentences can later be expanded to
three paragraphs which are the inner body of a five paragraph theme.

Revising Tools

STRUCTURE Tool

This tool has nine different checks:
. Outline Document

Paragraph Coherence
Paragraph Development

List by Sentence

Sentence Lengths

Category Match

Subordinate Clauses

Word Frequencies

Structure Summary

RN H W=

AUDIENCE Tool

This tool has eight checks:

. Readability Index

Diction Level

Transitions

Prepositions

References

"To be" Verbs

Sweet or Stuffy

(Based on the results of five analyses, this is an informal evaluation of
strengths and weaknesses of writing)
8. Audience Summary

NO RN

CHECKS Tool

This component has three checks:
1. Usage
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2. Homonyms
3. Gender

Notes:
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Writing with the Macintosh using Microsoft
Word

Authors:

Ann Hill Durin
Kathleen S. Gorak

Publisher:

Course Technology, Inc.
One Main Street
Cambridge, MA 02142
617-225-2595

Description:

This 1991 book is a text for a basic writing class. Its strength is its
fundamental premise: use basic features of a word processor to create pre-
writing and organizational activities. The book comes with numerous
templates designed in and for Microsoft Word 4.0. The High Tech Center
(HTCTU) has converted these files to PC format and they work well in Word
95. The HTCTU also uses the template files with Word 5.1 for the Mac.

Recommended Uses:

The text is recommended reading for anyone who is involved in teaching
writing or assisting students in the writing process. Ideas to augment
existing curriculum abound.

Notes:

In July of 1997, the HCTU checked with Course Technology about the
availability of the book. They responded with the comment that they no

longer published the book, and it may have been transferred to another
publisher.
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Mediated Learning http://www.academic.corn/courses/mlconceptasp

ACADEMIC

Mediated Learning

A new model of technology-mediated instruction and learning.

Mediated Learning is a faculty-guided, learner-centered approach to instruction and learning that takes
advantage of the combined strengths of the instructor, the learner and multimedia technology to create an
individualized learning environment and increase student academic achievement.

The basic Mediated Learning model is simple. Mediated Learning preserves the core elements of the
traditional model of instruction -- student, faculty, text -- and it introduces a new element,
computer-mediated instruction, assessment and support. The new model mOdIerS the role of each element
of instruction so that the individual needs of the student are -
addressed.Mediated Learning gives students better access to
more learning resources, when they need them and at the level
they require. Faculty can leverage scarce and valuable resources
-- including their expertise and their time -- and gain more
flexibility in the allocation of resources within their department.

LEARNERS \

Mediated Learning is founded on the research of the last few
decades and informed by the wisdom of practice -- distilled from
the experiences of outstanding faculty from across the country.
Mediated Learning courses are created by experienced faculty
and developers at Academic Systems, in collaboration with
faculty and researchers at colleges and universities throughout
the United States.

Madizied Lomrnina
Cormpridwsngive Maiructina
$othesmates To™>
Real-Time Asweamed
kireloolauati2e4 Lintrwg Matogetneot

I Fecultv and %Klatt SullPod

Academic Systems provides Mediated Learning courses to colleges and universities. Currently, courses are
available for entry-level mathematics, and soon courses will be available in other subject areas, including
English.

The technology supporting the Mediated Learning approach is a highly effective combination of
multimedia instructional software, real-time assessment and feedback, and an advanced Instructional
Support System that provides useful information to instructors and valuable guidance to students.

Academic Systems works in partnership with the faculty and staff at each campus to implement Mediated
Learning courses. Academic Systems provides each campus with the software, texts, faculty support and
technical support needed to implement Mediated Learning courses.

Academic Systems and its higher education partners have implemented Mediated Learning in entry-level

mathematics courses on college and university campuses across the country. The result has been
enthusiastic faculty and successful students.
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Mediated Learning http://www.academic.com/courses/mlconcept.asp

MEDIATED LEARNING

* Increased student achievement

* More flexibility for faculty and students

* Distributed learning over wide area networks
» Better use of resources

Together with its higher education partners, Academic Systems is continuing to develop new courses and
improve current courses. At the same time, Academic Systems and its partners are working together to
enhance the flexibility, reach and impact of Mediated Learning by making courses available over
interactive networks that extend across campuses and communities.

The promise of Mediated Learning is greater learning success, greater student retention, a more rewarding
environment for faculty, and a transformation of higher education to meet the new challenges facing
colleges and universities today.

For more information, visit:

Mediated Learning Library. Review detailed papers about Mediated Learning. The Mediated
Learning Library is part of the Research Library.

Mediated Learning Courses. Access detailed information about interactive multimedia courses.
Faculty Collaboration. Participate in discussions and share ideas with faculty nationwide who are
using Mediated Learning to help make students even more successful.

To return to the home page of AcademicNet, click Home below.

OArAdemic
Systems, 1996

HOME WORKSHOPS SEARCH REPRINTS MAP
[Home ; Workshops : Search : Reprints : Map]

[Courses ; Collaboration : Research r News : Support

We welcome your comments and questions about AcademicNet. Please give us your Feedback or you can send us email at info@academic.com.

20f2 1/14/98 6:28 PM






	Page 1
	Page 2
	Page 3
	Page 4
	Page 5
	Page 6
	Page 7
	Page 8
	Page 9
	Page 10
	Page 11
	Page 12
	Page 13
	Page 14
	Page 15
	Page 16
	Page 17
	Page 18
	Page 19
	Page 20
	Page 21
	Page 22
	Page 23
	Page 24
	Page 25
	Page 26
	Page 27
	Page 28
	Page 29
	Page 30
	Page 31
	Page 32
	Page 33
	Page 34
	Page 35
	Page 36
	Page 37
	Page 38
	Page 39
	Page 40
	Page 41
	Page 42
	Page 43
	Page 44
	Page 45
	Page 46
	Page 47
	Page 48
	Page 49
	Page 50
	Page 51
	Page 52
	Page 53
	Page 54
	Page 55
	Page 56
	Page 57
	Page 58
	Page 59
	Page 60
	Page 61
	Page 62
	Page 63
	Page 64
	Page 65
	Page 66
	Page 67
	Page 68
	Page 69
	Page 70
	Page 71
	Page 72
	Page 73
	Page 74
	Page 75
	Page 76
	Page 77
	Page 78
	Page 79
	Page 80
	Page 81
	Page 82

